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USB 3.0 Electrical Compliance Test Application — At A Glance

The Agilent U7243A USB 3.0 Electrical Compliance Test Application helps
you verify the USB 3.0 device complies to the electrical requirements on
the SuperSpeed physical layer as defined in the USB 3.0 specification,
with the Agilent Infiniium digital storage oscilloscopes. The USB 3.0
Electrical Compliance Test Application:

e Lets you select individual or multiple tests to run.
e Lets you identify the device being tested and its configuration.

* Shows you how to make oscilloscope connections to the device under
test.

* Automatically checks for proper oscilloscope configuration.
¢ Automatically sets up the oscilloscope for each test.

¢ Provides detailed information for each test that has been run and lets
you specify the thresholds at which marginal or critical warnings
appear.

* Creates a printable HTML report of the tests that have been run.

The tests performed by the USB 3.0 Electrical Compliance Test Application are intended to
provide a quick check of the electrical health of the DUT. This testing is not a replacement
for an exhaustive test validation plan.

Compliance testing measurements are described in the Universal Serial
Bus (USB) 3.0 Specification revision 1.0. For more information, see the
USB 3.0 standards web site at www.usb.org.

Required Equipment and Software

In order to run the USB 3.0 Electrical Compliance Test Application, you
need the following equipment and software:

e U7243A USB 3.0 Electrical Compliance Test Application software.

e 80000B or 90000A Series Infiniium Digital Storage Oscilloscope (DSO).
Agilent recommends using 13 GHz and higher bandwidth oscilloscope,
with at least 1M memory depth.

e Version 5.71 or greater of Infiniium software (80000B Series
oscilloscope) OR

e Version 1.40 or greater of Infiniium software (90000A Series
oscilloscope).

* Agilent also recommends using a second monitor to view the automated
test application.

* Precision BNC to SMA adapter, quantity = 2.
* 50 ohm coaxial cable (24 inches or shorter), quantity = 2 OR
¢ 1169A Infiniimax probe, quantity = 2.
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e U7242A USB 3.0 test fixture.

e Keyboard, quantity = 1 (provided with Agilent Infiniium oscilloscope).
e Mouse, quantity = 1 (provided with Agilent Infiniium oscilloscope).
Below is the required license:

e U7243A USB 3.0 Electrical Compliance Test Application license.

e E2688A Serial Data Analysis and Clock Recovery software (optional).
e N5401A EZJIT Plus software (optional).

USB 3.0 Electrical Compliance Testing Methods of Implementation



In This Book

This manual describes the tests that are performed by the USB 3.0
Electrical Compliance Test Application in more detail; it contains
information from (and refers to) the Universal Serial Bus (USB) 3.0
Specification revision 1.0 and it describes how the tests are performed.

Chapter 1, “Installing the USB 3.0 Electrical Compliance Test
Application” shows how to install and license the automated test
application software (if it was purchased separately).

Chapter 2, “Preparing to Take Measurements” shows how to start the
USB 3.0 Electrical Compliance Test Application and gives a brief
overview of the required preparation and how the application is used.

Chapter 3, “Near End (TPO) Transmitter Eye Tests” contains the details
of the this Near End, TPO tests as specified in the Universal Serial Bus
(USB) 3.0 Specification revision 1.0.

Chapter 4, “Far End (TP1) Transmitter Eye Tests” contains the details
of the this Far End, TP1 tests as specified in the Universal Serial Bus
(USB) 3.0 Specification revision 1.0.

Chapter 5, “Calibrating the 80000B and 90000A Series Infiniium

Oscilloscopes” describes how to calibrate the oscilloscope in preparation
for running the USB3.0 automated tests.

See Also

The USB 3.0 Electrical Compliance Test Application’s online help, which
describes:

Creating or opening a test project.
Setting up tests.

Selecting tests.

Configuring selected tests.

User-defined compliance limits
Connecting the oscilloscope to the DUT.
Running tests.

Viewing test results.

Viewing/printing the HTML test report.

Saving test projects.
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U7243A USB 3.0 Electrical Compliance Test Application
Methods of Implementation

o0 @ Qo1

Installing the USB 3.0 Electrical
®.  Compliance Test Application

Installing the Software 11
Installing the License Key 11

If you purchased the U7243A USB 3.0 Electrical Compliance Test
Application separately, you need to install the software and license key.

Installing the Software

1

Make sure you have version 5.71 or greater of the Infiniium oscilloscope
software (80000B Series oscilloscope) OR version 1.40 or greater of the
Infiniium oscilloscope (90000A Series oscilloscope) by choosing
Help>About Infiniium... from the main menu.

To obtain the USB 3.0 Electrical Compliance Test Application, go to
Agilent website: http://www.agilent.com/find/usb.

The link for USB 3.0 Electrical Compliance Test Application will appear.
Double-click on it and follow the instructions to download and install
the application software.

Installing the License Key

Request a license code from Agilent by following the instructions on the
Entitlement Certificate.

You will need the oscillocope’s “Option ID Number”, which you can find
in the Help>About Infiniium... dialog.

After you receive your license code from Agilent, choose
Utilities>Install Option License....

In the Install Option License dialog, enter your license code and click
Install License.

Click OK in the dialog that tells you to restart the Infiniium
oscilloscope application software to complete the license installation.

Click Close to close the Install Option License dialog.

Agilent Technologies 1
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1 Installing the USB 3.0 Electrical Compliance Test Application

6 Choose File>Exit.

7 Restart the Infiniium oscilloscope application software to complete the
license installation.
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® U7243A USB 3.0 Electrical Compliance Test Application
o Methods of Implementation

o0 @ @02
Preparing to Take Measurements

o o
° ® o
* ] ‘ Calibrating the Oscilloscope 14
. Starting the USB 3.0 Electrical Compliance Test Application 15

Before running the USB 3.0 Electrical Compliance Test Application
automated tests, you should calibrate the oscilloscope. Once the
oscilloscope has been calibrated, you are ready to start the USB 3.0

Electrical Compliance Test Application and perform the measurements.

Agilent Technologies
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Preparing to Take Measurements

Calibrating the Oscilloscope

14

If you haven’t already calibrated the oscilloscope, see Chapter 5,
“Calibrating the 80000B and 90000A Series Infiniium Oscilloscopes”.

If the ambient temperature changes more than 5 degrees Celsius from the calibration
temperature, internal calibration should be performed again. The delta between the
calibration temperature and the present operating temperature is shown in the
Utilities>Calibration menu.

If you switch cables or probes between channels or other oscilloscopes, it is necessary to
perform cable and probe calibration again. Agilent recommends that, once calibration is
performed, you label the cables with the channel for which they were calibrated.

USB 3.0 Electrical Compliance Testing Methods of Implementation



Preparing to Take Measurements

Starting the USB 3.0 Electrical Compliance Test Application

1 From the Infiniium oscilloscope’s main menu, choose
Analyze>Automated Test Apps>USB3.0 Test.

Utilities Help

Math (FFT and more)... —
Histogram...
) {

Mask Test...

Jitter...

Serial Data...

ASA Oscilloscope Tools...
Unlicensed Apps >

Automated Test Apps » —

USB3 Test

2

USB3.0 -- USBE3 Device 1 *
File View Tools Help

= -

= SetUp lSeIectTests ] Configure ] Connect] Run Tests ] Results ] Html Report
0
-,T-l Device: Test Point Test Information
] f* Device W Tx Near End (TPO) Reference Clock

" Host [ Tx Far End (TP1) f+ 55C

" Hub [ Custom Eye Template € Clean Clock

. r De-Emphasis Mode
Device ID- Load template: & 3548
| " None
Embed/De-embed Seitings
" De-embed ( Embed {* MNone Test Method

Select embed/de-embed setup mode

Input Signal
Select input signal type: | Live signal

Load bin file: |

[ Brovse |

[

T _ Browse |
=

_Browee |

v LSBE-IF SigTest
v Agilent SDA

Test Report
User Comments:

0Tests  |Follow instructions to describe your test environment Connection: UNKMNOWN

Figure 1
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2  Preparing to Take Measurements

If USB 3.0 Test does not appear in the Automated Test Apps menu, the USB 3.0 Electrical
Compliance Test Application has not been installed (see Chapter 1, “Installing the USB 3.0
Electrical Compliance Test Application”).
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Preparing to Take Measurements 2

Figure 1 shows the USB 3.0 Electrical Compliance Test Application
main window. The task flow pane and the tabs in the main pane, show
the steps you take in running the automated tests:

Set Up Lets you identify the test environment, including
information about the device being tested and types
of input signals to test, either life signal captured
from the oscilloscope or pre-recorded signal saved
into the waveform files.

Select Tests Lets you select the tests you want to run. The tests
are organized hierarchically so you can select all tests
in a group. After tests are run, status indicators show
which tests have passed, failed, or not been run, and
there are indicators for the test groups.

Configure Lets you configure the test parameters (e.g. test type).

Connect Shows you how to connect the oscilloscope to the
device under test for the tests to be run.

Run Tests Starts the automated tests. If the connections to the
device under test need to be changed while multiple
tests are running, the tests pause, show you how to
change the connection, and wait for you to confirm
that the connections have been changed before
continuing.

Results Contains more detailed information about the tests
that have been run. You can change the thresholds at
which marginal or critical warnings appear.

HTML Report Shows a compliance test report that can be printed.

USB 3.0 Electrical Compliance Testing Methods of Implementation 17
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Preparing to Take Measurements

Online Help Topics

For information on using the USB 3.0 Electrical Compliance Test
Application, see its online help (which you can access by choosing
Help>Contents... from the application’s main menu).

The USB 3.0 Electrical Compliance Test Application’s online help
describes:

e Starting the USB 3.0 Electrical Compliance Test Application
To view/minimize the task flow pane
To view/hide the toolbar
¢ Creating or opening a test project.
e Setting up tests.
¢ Selecting tests.
¢ Configuring selected tests.
¢ Defining user-defined compliance limits.
¢ Connecting the oscilloscope to the DUT.
* Running tests.
e Viewing test results.
To delete the trials.
To show reference images and flash mask hits.
To change the display settings.
To change margin thresholds and report trial display.
To change the user prompt option.
To change the loading and auto-recovery option.
¢ Viewing/Exporting/Printing the HTML test report.

e Saving test projects.

USB 3.0 Electrical Compliance Testing Methods of Implementation



Preparing to Take Measurements 2

Setting Up the USB 3.0 Test Environment

Prior to making any USB 3.0 measurements, setup the oscilloscope and the
test environment as described below.

1 Preset the oscilloscope.

2 Find the optimum vertical scale for each channel (2 channels for
single-ended connection).

a
b
c

d

Find range = Vmax - Vmin
Find offset = (Vmax + Vmin)/2
Set the new range and offset

Repeat the previous steps three times to obtain an optimum scale

3 Form a differential signal for single-ended connection by subtracting D+
channel from D- channel. Assign differential channel to FUNCTION 1.

4 If Signal Check is enabled in the configuration tab, perform signal
pattern validity check:

a
b

c

Measure min and max pulse width of the differential signal
There are 2 types of test pattern; CP1 and CPO

CP1 test pattern = D10.2 which is 010101 0101

CPO test pattern = D0.0 which is 0110001011

To verify CP1 test pattern:

Check that nominal pulse width is 200ps

To verify CPO test pattern:

-Check that nominal maximum pulse width is 3 x 200ps

-Check that nominal minimum pulse width is 200ps

b Set the memory depth and sample rate:

Set sample rate to 40Gsa/s
Calculate the number of points per Ul = Sample rate/5Gb/s
Number of points = 40G/5G = 8 points per Ul

If de-embed or embed option is enabled, limit the memory depth to
2M

If de-embed or embed option is disabled, calculate the memory
depth as:

Memory depth = Number of points per Ul X Number of Uls to test
Set the calculated memory depth

USB 3.0 Electrical Compliance Testing Methods of Implementation 19
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Preparing to Take Measurements

f If the memory depth is insufficient, calculate the number of
acquisitions required to achieve the essential number of Uls to test:

Number of acquisitions = (Number of Uls to test)
(Actual mem depth / Number of point per UI)

Set time range as (1/Sample rate) X Memory depth.

Set flag to indicate that the oscilloscope has been set up. The entire
steps above should only be called once for each test run.

If the de-embed option is enabled, perform the signal de-embed as
follows:

Enable UDF function - "Deconvolve"

Assign UDF to FUNCTION 3 by using source from FUNCTION 1
(differential source)

Point S-parameter file to the user-defined file location
Turn off FUNCTION 1 and turn on FUNCTION 3

If the embed option is enabled, perform the signal embed:
Enable UDF function - "Convolve"

Assign UDF to FUNCTION 3 by using source from FUNCTION 1
(differential source)

Point S-parameter file to the user-defined file location
Turn off FUNCTION 1 and turn on FUNCTION 3

USB 3.0 Electrical Compliance Testing Methods of Implementation



Preparing to Take Measurements 2

Setting Up and Connecting USB 3.0 Test Fixture
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Figure 2 Block Diagram of U7242A USB 3.0 Test Fixture
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Preparing to Take Measurements

The U7242A USB 3.0 test fixture is required to perform the USB 3.0
electrical compliance test measurements. The fixture helps you to easily
access the USB 3.0 test signals.

The connection to this test fixture depends on the type of device under
test (DUT):

Dewvice
f¢ Device
" Host
" Hub

Device ID:

For Device test:

1

Connect DUT to J1 by using 4 inches USB 3.0 Standard-A to
Standard-B cable.

Connect J6 and J7 to the oscilloscope to measure USB 2.0 signal.

Connect J2 and J3 to the oscilloscope to measure the SuperSpeed (USB
3.0) Transmitter signal.

Connect J4 and J5 to the oscilloscope to measure the SuperSpeed (USB
3.0) Receiver signal.

For Host test:

1

Connect DUT to J8 by using 4 inches USB 3.0 Standard-A to
Standard-B cable.

Connect J13 and J14 to the oscilloscope to measure USB 2.0 signal.

Connect J11 and J12 to the oscilloscope to measure the SuperSpeed
(USB 3.0) Transmitter signal.

Connect J9 and J10 to the oscilloscope to measure the SuperSpeed
(USB 3.0) Receiver signal.

For Hub test:

* The connection for hub test depends on the type of hub:

Upstream hub follows the connection as per the Device test.

Downstream hub follows the connection as per the Host test.

USB 3.0 Electrical Compliance Testing Methods of Implementation
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3
Near End (TP0) Transmitter Eye Tests

Connection for Near End (TP0) Transmitter Eye Tests 24
Near End Unit Interval Test Method of Implementation 29
Near End SSC Slew Rate Test Method of Implementation 32
Near End Template Test Method of Implementation 34

Near End Peak-to-Peak Differential Output Voltage Test Method of
Implementation 37

Near End RMS Random Jitter Test Method of Implementation 39

Near End Maximum Deterministic Jitter Test Method of
Implementation 41

Near End Total Jitter at BER-12 Test Method of Implementation 43

This section provides the Methods of Implementation (MOIs) for Near End
(TPO) Transmitter Eye tests using an Agilent 80000B or 90000A Series
Infiniium oscilloscope, USB 3.0 test fixture and USB 3.0 Electrical
Compliance Test Application.

Agilent Technologies
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Near End (TPO) Transmitter Eye Tests

Connection for Near End (TP0) Transmitter Eye Tests

24

When performing the Near End (TPO) Transmitter Eye tests, the USB 3.0
Electrical Compliance Test Application will prompt you to make proper
connections. The connections for the Near End (TPO) Transmitter Eye tests
may look similar to the following diagram. Refer to the Connection tab in
USB 3.0 Electrical Compliance Test Application for more details.

P ™
. o ,
Oscillscope - SMP T DUT
If.\ j"w‘
L M
TPO

Figure 3  Connection for Near End (TP0) Transmitter Eye Tests

You may connect the SMP to SMA cables to any of the oscilloscope
channels. You can identify the channels used for each signal in the
Configuration tab of the USB 3.0 Electrical Compliance Test Application.
(The channels shown in Figure 3 is just an example).

Test Procedure

1 Start the automated test application as described in “Starting the USB
3.0 Electrical Compliance Test Application" on page 15.

2 In the USB3.0 Electrical test application, click the Set Up tab.

3 Under the Device information group, select the type of device under
test. Enter the device ID for reporting purpose.

Dewvice
f¢ Device
" Host
" Hub

Device ID:

4 Under the Test Point group, select the test point to perform the test.
The Near End (TPO) tests allows you to perform transmitter tests at the

USB 3.0 Electrical Compliance Testing Methods of Implementation



Near End (TP0) Transmitter Eye Tests 3

near end test point, TPO. This test point references Table 6-9, 6-10 and
Table 6-11 of the USB 3.0 Specification.

Test Point
v Tx Mear End (TPO)
| Tx Far End (TP1)

[ Custom Eye Template
Load template: r

| |

5 For Custom Eye Template, you may load your own eye template:

Test Point

[ Tx Mear End (TPO)

[ TxFar End (TP1)

v Custom Eye Template

Load template: [+ CTLE On

IC:\USB3Template d:  Browse

6 Check the “CTLE On” checkbox to enable the tests with CTLE. This
enables the equalization function when there are long cables and
channels that cause the eye at the receiver to close.

7 Under the Test Information group, you can specify the test parameters -
reference clock, de-emphasis mode and test method:

a Reference Clock - defines whether the device under test uses either
Spread Spectrum Clocking (SSC) or clean clock.

b De-emphasis mode - defines whether the transmitter signals include
de- emphasis.

¢ Test method - Defines either to use SigTest dll or Agilent's SDA and
EZJIT+ software, to perform the test analysis. Checking both
checkboxes enable both test modes.

Test Information
Reference Clock

¥ S5C
" Clean Clock

De-Emphasiz Mode
(v -35dB

" Mone

Test Method

v LUSE-IF SigTest
[+ Agilent SDA

USB 3.0 Electrical Compliance Testing Methods of Implementation 25
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Near End (TPO) Transmitter Eye Tests

If both E2688A Serial Data Analysis and N5401A EZJIT Plus options
are not available, the “Agilent SDA” checkbox will be disabled. If either
one of the license options is available, then the checkbox is enabled.

As mentioned earlier, if only the E2688A Serial Data Analysis option is
available, the “Agilent SDA” checkbox is enabled, however only the
following SDA tests are available:

Near End/Far End Template Tests (SDA)

Near End/Far End Peak-to-Peak Differential Output Voltage Test
(SDA)

Similarly, if only the N5401A EZJIT Plus option is available, the “Agilent
SDA” checkbox is also enabled but only the following SDA tests are
available:

Near End/Far End RMS Random Jitter (SDA)
Near End/Far End Maximum Deterministic Jitter (SDA)
Near End/Far End Total Jitter At BER-12 (SDA)

Under the Embed/De-embed Settings group, you can define if the signal
embed/de-embed is required. You may want to perform power
de-embedding to compensate loss from the test fixture and probes.
Similarly, you may also perform signal embed to simulate power loss
conditions. You should provide the S-parameter file of the system under
test to perform signal power embed or de-embed:

a Embed - This option calls for the UDF function "Convolve".
FUNCTION 3 is assigned to "Convolve" FUNCTION 1, which is the
differential source.

b De-embeded - This option calls for the UDF function "Deconvolve".
FUNCTION 3 is assigned to "Deconvolve" FUNCTION 1, which is the
differential source.

¢ None - No embed or de-embed takes place and the original
differential source on FUNCTION 1 is used to perform the analysis.

Embed/De-embed Setings
" De-embed {* Embed " MNone

Select embed/de-embed setup rr'ﬂde|;.'.,|_rt.;.mate.:| Setup j

Software will automate embed/de-embed setup.

Load S-parameter: |C\Documents and Settings'All  Browse

USB 3.0 Electrical Compliance Testing Methods of Implementation



Near End (TPO) Transmitter Eye Tests

9 Under the Input Signal group, you may decide either to capture life

3

signal from the oscilloscope or load a pre-recorded signal to be tested:

a Live Signal - Live signal is captured and analyzed directly from the
oscilloscope.

b Recorded Signal - Pre-recorded waveform saved as waveform file
(*.bin) format is loaded and analyzed. Only tests carried out by the
USB-IF Sigtest are available with this option.

Input Signal
Select input signal t;pe:|Uve signal -

Load bin file: |

10 Under the Test Report group, you may enter comments to be included
in the test report.

Test Report

|Iser Comments:

11 Click the Select Tests tab and check the tests you want to run. Check
the parent node or group to check all the available tests within the
group.

USB 3.0 Electrical Compliance Testing Methods of Implementation
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3 Near End (TP0) Transmitter Eye Tests

USB3.0 -- USB3 Device
File View Tools Help

D@ 202 @ e

Task Flow _| Setup SelectTests | Configure | Connect | Run Tests | Resuts | Himi Report

Fl =[] O AllUSE3 Tests
£ =[O UsB3Tests (5.0G6Tf)

() Transmitter Eye Mear End (TPO) Tests

) Mear End Unit Interval (with S5C)

) Mear End S5C Slew Rate

) Mear End Template Test

) Mear End Peak-To-Peak Differential Qutput Voltage
) Mear End RMS Random Jitter

) Mear End Maximum Deterministic Jitter

Mear End Total Jitter at BER-12

Select Tests

Description: (Select a Single Test)
Limit Set: USE 3.0 Specifcation version 1.0

Test: (None Selected)

I 7 Tests |Check the test(s) you would like to run |Cor1r1ecﬁon: LNEMOWN Y

Figure 4  Selecting Near End (TP0) Transmitter Eye Tests

12 Set up the test parameters in the configuration options, run the test,
and view the test results.
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Near End (TPO) Transmitter Eye Tests

Near End Unit Interval Test Method of Implementation

3

The purpose of this test is to verify that the unit interval measured at the
TPO of the transmitter is within the conformance limits specified in Table
6- 10 (without SSC) and Table 6-9 (with SSC) of the USB 3.0 specification.

Test Definition Notes from the Specification

Table 1  Transmitter Normative Electrical Parameters
Symbol Parameter 5.0 GT/s Units  Parameter
ul Unit Interval 199.94 (min) ps The specified Ul is equivalent to a tolerance of +
200.06 (max) 300ppm for each device. Period does not account for
SSC induced variations.
V1x-DIFFE-PP Differential p-p 0.8 (min) v Nominal is 1V p-p.
Tx voltage swing 1.2 (max)

Vix.Dire-ppLow  Low-Power 0.4 (min) v There is no de-emphasis requirement in this mode.
Differential p-p 1.2 (max) De-emphasis is implementation-specific for this
Tx voltage swing mode.

V1X-DE-RATIO Tx de-emphasis 3.0 (min) dB Nominal is 3.5 dB.

4.0 (max)

RTX-DlFF-DC DC differential 72 (min) Q
impedance 120 (max)

Vix.Rrev.peETECT  The amount of 0.6 (max) v Detect voltage transition should be an increase in
voltage change voltage on the pin looking at the detect signal to avoid
allowed during a high impedance requirement when an “off”
Receiver Detection receiver’s input goes below ground.

CAC-COUPLING AC Coupling 75 (min) nF All Transmitters shall be AC coupled. The AC coupling
Capacitor 200 (max) is required either within the media or within the

transmitting component itself.

tcpr stew max ~ Maximum slew rate 10 ms/s  See the jitter white paper for details on this

measurement. This is a df/ft specification.
Table 2 SSC Parameters
Symbol Description Limits Units Note
Min Max
tSSC-MOD-RATE Modulation Rate 30 33 kHz
tSSC-FREQ-DEVIATlON SSC deviation +0/-4000 +0/-5000 ppm 1.2

USB 3.0 Electrical Compliance Testing Methods of Implementation
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NOTE:

1

2

The data rate is modulated from Oppm to -5000ppm of the nominal
data rate frequency and scales with data rate.

This is measured below 2 MHz only.

Table 6-9 translates to:

Max Unit Interval = 200.0ps + 5300ppm = 201.06ps

Min Unit Interval = 200.0ps - 300ppm = 199.94ps

Measurement Algorithm

1

10
1"

Make the connections as described in “Setting Up the USB 3.0 Test
Environment" on page 19. The horizontal and vertical scales of the
oscilloscope are adjusted as described in there.

Save the oscilloscope settings prior to turning on the measurement
trending. The saved settings will be reloaded at the end of this test so
that the next test does not need to perform the steps described in
“Setting Up the USB 3.0 Test Environment“ again.

Split the oscilloscope's display into 2 graticules: the top displays the
source waveform and the bottom displays the unit interval trend
waveform.

Turn on the unit interval measurement.

Enable the jitter mode to view measurement trends. Enable the
measurement trend to trend the unit interval measurement with 3499
smoothing points.

Assign FUNCTION 4 to magnify the measurement trend at a factor of 1.
Autoscale FUNCTION 4 so that the full signal is displayed.

Measure the average of FUNCTION 4 to obtain the average unit interval.
Measure the max of FUNCTION 4 to get the maximum unit interval.
Measure the min of FUNCTION 4 to get the minimum unit interval.
Compare the test result with the compliance test limit.

Reload the saved oscilloscope settings before proceeding to the next
test.

Pass Condition

The measured average unit interval at TPO is within the limits specified in
Table 6-10 (without SSC) and Table 6-9 (with SSC) of the USB 3.0
Specification.
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Test References

See Table 6-10 Transmitter Normative Electrical Parameters and Table 6-9
SSC Parameters in the USB 3.0 Specification, version 1.0.
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Near End SSC Slew Rate Test Method of Implementation

The purpose of this test is to ensure that the combination of SSC and all
other jitter sources within the bandwidth of the CDR does not exceed the
allowed slew rate. The peak of the period jitter must not exceed
Tepr sLEw max listed in Table 6-10 of the USB 3.0 specification.

Test Definition Notes from the Specification

Table 3 Transmitter Normative Electrical Parameters

Symbol Parameter 5.0 GT/s Units  Parameter
ul Unit Interval 199.94 (min) ps The specified Ul is equivalent to a tolerance of +
200.06 (max) 300ppm for each device. Period does not account for
SSC induced variations.
V1x.DIFE-PP Differential p-p 0.8 (min) v Nominalis 1V p-p.
Tx voltage swing 1.2 (max)

Vix.Dire-pLow  Low-Power 0.4 (min) v There is no de-emphasis requirement in this mode.
Differential p-p 1.2 (max) De-emphasis is implementation-specific for this
Tx voltage swing mode.

V1x-DE-RATIO Tx de-emphasis 3.0 (min) dB Nominal is 3.5 dB.

4.0 (max)

RTX-DlFF-DC DC differential 72 (min) Q
impedance 120 (max)

Vxrev.peTect  The amount of 0.6 (max) v Detect voltage transition should be an increase in
voltage change voltage on the pin looking at the detect signal to avoid
allowed during a high impedance requirement when an “off”
Receiver Detection receiver’s input goes below ground.

CAC-COUPLING AC Coupling 75 (min) nF All Transmitters shall be AC coupled. The AC coupling
Capacitor 200 (max) is required either within the media or within the

transmitting component itself.

tcpr stew max ~ Maximum slew rate 10 ms/s  See the jitter white paper for details on this
measurement. This is a df/ft specification.

Measurement Algorithm

1 Make the connections as described in “Setting Up the USB 3.0 Test
Environment" on page 19. The horizontal and vertical scales of the
oscilloscope are adjusted as described in there.

2 Save the oscilloscope settings prior to turning on the measurement
trending. The saved settings will be reloaded at the end of this test so
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that the next test does not need to perform the steps described in
“Setting Up the USB 3.0 Test Environment® again.

3 Split the oscilloscope's display into 2 graticules: the top displays the
source waveform and the bottom displays the unit interval trend
waveform.

4 Turn on the unit interval measurement.

5 Enable the jitter mode to view the measurement trends. Enable the
measurement trend to trend the unit interval measurement with 3499
smoothing points.

6 Assign FUNCTION 4 to magnify the measurement trend at a factor of 1.
Autoscale FUNCTION 4 so that the full signal is displayed.

7 Read the measurement trend waveform into the memory.

8 The saved waveform is analyzed by using MATLAB. For the algorithm to
determine the slew rate, refer to white paper USB 3.0 CDR Model
White Paper, revision 0.5 available at www.usb.org.

9 Compare the test result with the compliance test limit.

10 Reload the saved oscilloscope settings before proceeding to the next
test.

Pass Condition

The maximum slew rate must not exceed the slew rate limit in Table 6-10
of the USB 3.0 Specification.

Test References

See Table 6-10 Transmitter Normative Electrical Parameters in the USB
3.0 Specification, version 1.0.
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Near End Template Test Method of Implementation

The purpose of this test is to perform an eye mask test at TPO by using
the specifications specified in Section 6.7.1, Tables 6-10 and 6-11 of the
USB 3.0 specification.

Table 6-10 specifies that Differential p-p Tx Voltage Swing should be
0.8-1.2V.

Table 6-11 specifies that Transmitter Eye is 0.625 UI, which is the total
jitter.

Table 6-11 also specifies that deterministic jitter is 0.205 Ul
Therefore, the near end transmitter eye test uses the following limits:
e Upper/Lower rail = 1.2Vmax, i.e. +/- 0.6V

¢ Diamond upper/lower = 0.8Vmin, i.e. +/- 0.4V

¢ Diamond width

Transmitter eye specified in Table 6-11

0.625 UI/2 = +/-0.3125U1

Test Definition Notes from the Specification

Table4 Transmitter Normative Electrical Parameters

Symbol Parameter 5.0 GT/s Units  Parameter
ul Unit Interval 199.94 (min)  ps The specified Ul is equivalent to a tolerance of +
200.06 (max) 300ppm for each device. Period does not account for
SSC induced variations.
V1x-DIFF-PP Differential p-p 0.8 (min) v Nominalis 1V p-p.
Tx voltage swing 1.2 (max)
Vix.Dire-ppLow  Low-Power 0.4 (min) v There is no de-emphasis requirement in this mode.
Differential p-p 1.2 (max) De-emphasis is implementation-specific for this
Tx voltage swing mode.
V1X-DE-RATIO Tx de-emphasis 3.0 (min) dB Nominal is 3.5 dB.
4.0 (max)
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Table 5 Transmitter Informative Electrical Parameters at Silicon Pads

Symbol Parameter 5.0 GT/s Units  Parameter

tMIN-PULSE-D] Deterministic min 0.96 ul Tx pulse width variation that is deterministic.
pulse

tMIN-PULSET] Tx min pulse 0.90 ul Min Tx pulse at 10"'% including Dj and R.

IX-EYE Transmitter Eye 0.625 (min) ul Includes all jitter sources.

tr%.DJ-DD Tx deterministic jitter  0.205 (max) ul Deterministic jitter only assuming the Dual Dirac

distribution

Crx-PARASITIC Tx input capacitance  1.25 (max) pf Parasitic capacitance to ground
for return loss

Rrx.nc Transmitter DC 18 (min) Q DC impedance limits to guarantee Receiver detect
common mode 30 (max) behavior. Measured with respect to AC ground over a
impedance voltage of 0-500 mV.

Measurement Algorithm

1 Make the connections as described in “Setting Up the USB 3.0 Test
Environment" on page 19. The horizontal and vertical scales of the
oscilloscope are adjusted as described in there.

2 Using the USB-IF SigTest:

Acquire and save the waveform into

C:\Documents and Settings\All Users\Application Data\Agilent\
Infiniium\Apps\USB3Test\Project\USB3.bin

Call the USB SigTest to analyze the saved waveform
3 Using the Agilent SDA:
Turn on the color grade display.

Enable the mask test and load the mask. The mask template can be
found at:

C:\Program Files\Agilent\Infiniium\Apps\USB3Test\app\masks\
USBMask_NearEnd.msk

Set up the clock recovery by using 2nd order PLL with data rate of
5Gb/s, loop bandwidth of 4.9MHz and damping factor of 0.707.

Enable Real Time Eye to fold the waveform.

4 Compare the test result with the compliance test limit.

Pass Condition

The test passes if the waveform does not violate the mask.

USB 3.0 Electrical Compliance Testing Methods of Implementation 35



3 Near End (TP0) Transmitter Eye Tests

Test References

See Table 6-10 Transmitter Normative Electrical Parameters and Table
6-11 Transmitter Informative Electrical Parameters at Silicon Pads in the
USB 3.0 Specification, version 1.0.

36 USB 3.0 Electrical Compliance Testing Methods of Implementation



Near End (TP0) Transmitter Eye Tests 3

Near End Peak-to-Peak Differential Output Voltage Test Method of

Implementation

The purpose of this test is to verify that the peak-to-peak differential
output voltage, Vrx.pirr-pp measured at TPO is within the limits as
specified in Table 6-10 of the USB 3.0 specification.

Test Definition Notes from the Specification

Table 6 Transmitter Normative Electrical Parameters

Symbol Parameter 5.0 GT/s Units  Parameter
ul Unit Interval 199.94 (min) ps The specified Ul is equivalent to a tolerance of +
200.06 (max) 300ppm for each device. Period does not account for
SSC induced variations.
V1x.DIFE-PP Differential p-p 0.8 (min) v Nominal is 1V p-p.
Tx voltage swing 1.2 (max)

Vix.Dire-pLow  Low-Power 0.4 (min) v There is no de-emphasis requirement in this mode.
Differential p-p 1.2 (max) De-emphasis is implementation-specific for this
Tx voltage swing mode.

V1x-DE-RATIO Tx de-emphasis 3.0 (min) dB Nominal is 3.5 dB.

4.0 (max)

RTX-DlFF-DC DC differential 72 (min) Q
impedance 120 (max)

Vxrev.peTect  The amount of 0.6 (max) v Detect voltage transition should be an increase in
voltage change voltage on the pin looking at the detect signal to avoid
allowed during a high impedance requirement when an “off”
Receiver Detection receiver’s input goes below ground.

CAC-COUPLING AC Coupling 75 (min) nF All Transmitters shall be AC coupled. The AC coupling
Capacitor 200 (max) is required either within the media or within the

transmitting component itself.

tcpr stew max ~ Maximum slew rate 10 ms/s  See the jitter white paper for details on this

measurement. This is a df/ft specification.

Measurement Algorithm

USB 3.0 Electrical Compliance Testing Methods of Implementation

1

Make the connections as described in “Setting Up the USB 3.0 Test
Environment" on page 19. The horizontal and vertical scales of the
oscilloscope are adjusted as described in there.

Using the USB-IF SigTest:

Acquire and save the waveform into
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C:\Documents and Settings\All Users\Application Data\Agilent\
Infiniium\Apps\USB3Test\Project\USB3.bin

Call the USB SigTest to analyze the saved waveform
3 Using the Agilent SDA:
Turn on the color grade display.

Set up the clock recovery by using 2nd order PLL with data rate of
5Gb/s, loop bandwidth of 4.9MHz and damping factor of 0.707.

Enable the Real Time Eye to fold the waveform.
Measure the min and max value of the waveform.

The peak differential voltage is

Peak diff voltage = Max voltage - Min voltage

4 Compare the test result with the compliance test limit.

Pass Condition

The measured peak-to-peak differential output voltage is within the limit
as specified in Table 6-10 of the USB 3.0 specification.

Test References

See Table 6-10 Transmitter Normative Electrical Parameters in the USB
3.0 Specification, version 1.0.
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Near End RMS Random Jitter Test Method of Implementation

The purpose of this test is to verify that the measured RMS random jitter,
Rj measured at TPO is within the limits as specified in Table 6-11 of the
USB 3.0 specification.

Rj Total is computed as the Root Sum Square of the individual Rj

components.

Table 6-11 specifies that Transmitter Eye is 0.625 Ul which is the total

jitter.

Table 6-11 also specifies that deterministic jitter is 0.205 Ul

Therefore, the near end jitter limits uses the following calculation:

e Tj = 1UI - 0.625UI = 0.375UI
0.205U1
(Tj - Dj)/14.068 = (0.375 - 0.205)/14.068 = 0.013UI

.DJ
.RJ

Test Definition Notes from the Specification

Table 7 Transmitter Informative Electrical Parameters at Silicon Pads

Symbol Parameter 5.0 GT/s Units  Parameter

UMIN-PULSE-D] Deterministic min 0.96 ul Tx pulse width variation that is deterministic.
pulse

UMIN-PULSET] Tx min pulse 0.90 ul Min Tx pulse at 10"'? including Dj and R.

trx-EVE Transmitter Eye 0.625 (min) ul Includes all jitter sources.

tr%-DJ-DD Tx deterministic jitter ~ 0.205 (max) ul Deterministic jitter only assuming the Dual Dirac

distribution

Crx-PARASITIC Tx input capacitance  1.25 (max) pf Parasitic capacitance to ground
for return loss

Rrx.oc Transmitter DC 18 (min) Q DC impedance limits to guarantee Receiver detect
common mode 30 (max) behavior. Measured with respect to AC ground over a
impedance voltage of 0-500 mV.

Measurement Algorithm

USB 3.0 Electrical Compliance Testing Methods of Implementation

1 Make the connections as described in “Setting Up the USB 3.0 Test
Environment" on page 19. The horizontal and vertical scales of the
oscilloscope are adjusted as described in there.

2 Using the USB-IF SigTest:

Acquire and save the waveform into
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C:\Documents and Settings\All Users\Application Data\Agilent\
Infiniium\Apps\USB3Test\Project\USB3.bin

Call the USB SigTest to analyze the saved waveform
3 Using the Agilent SDA (in this case, the EZJIT+):
Enable Jitter mode on EZJIT+.
Perform RjDj measurements by using the following setup:
BER: E-12
Pattern length: arbitrary
Leading coefficient: -2
Lagging coefficient: 5
Rj Bandwidth: Narrow

Setup clock recovery:

2nd Order PLL, data rate of 5Gb/s, loop bandwidth of 4.9MHz, damping
factor of 0.707

Get Rj reading
4 Compare the test result with compliance test limit.
Pass Condition

The measured RMS random jitter, Rj measured at TPO is within the limit
as specified in Table 6-11 of the USB 3.0 specification.

Test References

See Table 6-11 Transmitter Informative Electrical Parameters at Silicon
Pads in the USB 3.0 Specification, version 1.0.
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Near End Maximum Deterministic Jitter Test Method of Implementation

The purpose of this test is to verify that the measured deterministic jitter,
Dj measured at TPO is within the limits as specified in Table 6-11 of the
USB 3.0 specification.

Dj is computed using the Dual Dirac method.

Table 6-11 specifies that deterministic jitter is 0.205 UL

Test Definition Notes from the Specification

Table 8 Transmitter Informative Electrical Parameters at Silicon Pads

Symbol Parameter 5.0 GT/s Units  Parameter

tMIN-PULSE-D] Deterministic min 0.96 ul Tx pulse width variation that is deterministic.
pulse

tMIN-PULSE-T] Tx min pulse 0.90 ul Min Tx pulse at 10"'2 including Dj and R.

I%-EYE Transmitter Eye 0.625 (min) ul Includes all jitter sources.

trx.0J-0D Tx deterministic jitter ~ 0.205 (max) ul Deterministic jitter only assuming the Dual Dirac

distribution

Crx.PARASITIC Tx input capacitance  1.25 (max) pf Parasitic capacitance to ground
for return loss

Rrx.nc Transmitter DC 18 (min) Q DC impedance limits to guarantee Receiver detect
common mode 30 (max) behavior. Measured with respect to AC ground over a

impedance

voltage of 0-500 mV.

Measurement Algorithm

USB 3.0 Electrical Compliance Testing Methods of Implementation

1 Make the connections as described in “Setting Up the USB 3.0 Test
Environment" on page 19. The horizontal and vertical scales of the
oscilloscope are adjusted as described in there.

2 Using the USB-IF SigTest:

Acquire and save the waveform into

C:\Documents and Settings\All Users\Application Data\Agilent\
Infiniium\Apps\USB3Test\Project\USB3.bin

Call the USB SigTest to analyze the saved waveform
3 Using the Agilent SDA (in this case, the EZJIT+):
Enable Jitter mode on EZJIT+.

Perform RjDj measurements by using the following setup:
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BER: E-12

Pattern length: arbitrary
Leading coefficient: -2
Lagging coefficient: 5

Rj Bandwidth: Narrow

Setup clock recovery:

2nd Order PLL, data rate of 5Gb/s, loop bandwidth of 4.9MHz, damping
factor of 0.707

Get Dj reading

4 Compare the test result with compliance test limit.

Pass Condition

The measured maximum deterministic jitter, Dj measured at TPO is within
the limit as specified in Table 6-11 of the USB 3.0 specification.

Test References

See Table 6-11 Transmitter Informative Electrical Parameters at Silicon
Pads in the USB 3.0 Specification, version 1.0.
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Near End Total Jitter at BER-12 Test Method of Implementation

The purpose of this test is to verify that the measured total jitter, Tj
measured at TPO is within the limits as specified in Table 6-11 of the USB
3.0 specification.

Tj at a 10"'2 BER is calculated as 14.068 x Rj + Dj.

Table 6-11 specifies that Transmitter Eye is 0.625 Ul Total jitter is 1UI -
Transmitter eye = 1 - 0.625 = 0.375 Ul

Test Definition Notes from the Specification

Table9 Transmitter Informative Electrical Parameters at Silicon Pads

Symbol Parameter 5.0 GT/s Units  Parameter

tMIN-PULSE-D] Deterministic min 0.96 ul Tx pulse width variation that is deterministic.
pulse

UMIN-PULSET] Tx min pulse 0.90 ul Min Tx pulse at 10"'2 including Dj and R.

tIX-EYE Transmitter Eye 0.625 (min) ul Includes all jitter sources.

trx.DJ-DD Tx deterministic jitter  0.205 (max) ul Deterministic jitter only assuming the Dual Dirac

distribution

Crx-pARASITIC Tx input capacitance  1.25 (max) pf Parasitic capacitance to ground
for return loss

Rry.nc Transmitter DC 18 (min) Q DC impedance limits to guarantee Receiver detect
common mode 30 (max) behavior. Measured with respect to AC ground over a

impedance

voltage of 0-500 mV.

Measurement Algorithm

USB 3.0 Electrical Compliance Testing Methods of Implementation

1 Make the connections as described in “Setting Up the USB 3.0 Test
Environment" on page 19. The horizontal and vertical scales of the
oscilloscope are adjusted as described in there.

2 Using the USB-IF SigTest:

Acquire and save the waveform into

C:\Documents and Settings\All Users\Application Data\Agilent\
Infiniium\ Apps\USB3Test\Project\USB3.bin

Call the USB SigTest to analyze the saved waveform
3 Using the Agilent SDA (in this case, the EZJIT+):
Enable Jitter mode on EZJIT+.

Perform RjDj measurements by using the following setup:
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BER: E-12

Pattern length: arbitrary

Leading coefficient: -2

Lagging coefficient: 5

Rj Bandwidth: Narrow
Setup clock recovery:

2nd Order PLL, data rate of 5Gb/s, loop bandwidth of 4.9MHz, damping
factor of 0.707

Get Rj and Dj reading

Calculate total jitter Tj using formula:
Tj = 14.068 * Rj + Dj
4 Compare the test result with compliance test limit.
Pass Condition

The measured total jitter, Tj measured at TPO is within the limit as
specified in Table 6-11 of the USB 3.0 specification.

Test References

See Table 6-11 Transmitter Informative Electrical Parameters at Silicon
Pads in the USB 3.0 Specification, version 1.0.
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This section provides the Methods of Implementation (MOIs) for Far End
(TP1) Transmitter Eye tests using an Agilent 80000B or 90000A Series
Infiniium oscilloscope, USB 3.0 test fixture and USB 3.0 Electrical
Compliance Test Application.
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Far End (TP1) Transmitter Eye Tests

Connection for Far End (TP1) Transmitter Eye Tests

When performing the Far End (TP1) Transmitter Eye tests, the USB 3.0
Electrical Compliance Test Application will prompt you to make proper
connections. The connections for the Far End (TP1) Transmitter Eye tests
may look similar to the following diagram. Refer to the Connection tab in
USB 3.0 Electrical Compliance Test Application for more details.

Oscilloscope

= -, Reference Reference
— SMP;-\ Test Channel Cable :[j sl
I S

46

™1 % Compliance Channel A

S-Parameters

Figure5 Connection for Far End (TP1) Transmitter Eye Tests

You may connect the SMP to SMA cables to any of the oscilloscope
channels. You can identify the channels used for each signal in the
Configuration tab of the USB 3.0 Electrical Compliance Test Application.
(The channels shown in Figure 5 is just an example).

Test Procedure

1 Start the automated test application as described in “Starting the USB
3.0 Electrical Compliance Test Application" on page 15.

2 In the USB3.0 Ethernet test application, click the Set Up tab.

3 Under the Device information group, select the type of device under
test. Enter the device ID for reporting purpose.

Dewice
f* Device
" Host
" Hub

Device ID:

4 Under the Test Point group, select the test point to perform the test.
The Far End (TP1) tests allows you to perform transmitter tests at the
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far end test point, TP1. This test point references Table 6-9, Table 6- 10
and Table 6-12 of the USB 3.0 Specification.

Test Point

[ Tx Mear End (TPO)

[v Tx Far End (TP1)

[ Custom Eye Template

Load template: | CTLEOn

| |

5 For Custom Eye Template, you may load your own eye template:

Test Point

[ Tx Mear End (TPO)

[ TxFar End (TP1)

v Custom Eye Template

Load template: [+ CTLE On

IC:\USB3Template d:  Browse

6 Check the “CTLE On” checkbox to enable the tests with CTLE. This
enables the equalization function when there are long cables and
channels that cause the eye at the receiver to close.

7 Under the Test Information group, you can specify the test parameters -
reference clock, de-emphasis mode and test method:

a Reference Clock - defines whether the device under test uses either
Spread Spectrum Clocking (SSC) or clean clock.

b De-emphasis mode - defines whether the transmitter signals include
de- emphasis.

¢ Test method - Defines either to use SigTest dll or Agilent's SDA and
EZJIT+ software, to perform the test analysis. Checking both
checkboxes enable both test modes.

Test Information
Reference Clock
¥ S5C

" Clean Clock

De-Emphasiz Mode
(v -35dB

" Mone

Test Method

v LUSE-IF SigTest
[+ Agilent SDA
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If both E2688A Serial Data Analysis and N5401A EZJIT Plus options
are not available, the “Agilent SDA” checkbox will be disabled. If either
one of the license options is available, then the checkbox is enabled.

As mentioned earlier, if only the E2688A Serial Data Analysis option is
available, the “Agilent SDA” checkbox is enabled, however only the
following SDA tests are available:

Near End/Far End Template Tests (SDA)

Near End/Far End Peak-to-Peak Differential Output Voltage Test
(SDA)

Similarly, if only the N5401A EZJIT Plus option is available, the “Agilent
SDA” checkbox is also enabled but only the following SDA tests are
available:

Near End/Far End RMS Random Jitter (SDA)
Near End/Far End Maximum Deterministic Jitter (SDA)
Near End/Far End Total Jitter At BER-12 (SDA)

Under the Embed/De-embed Settings group, you can define if the signal
embed/de-embed is required. You may want to perform power
de-embedding to compensate loss from the test fixture and probes.
Similarly, you may also perform signal embed to simulate power loss
conditions. You should provide the S-parameter file of the system under
test to perform signal power embed or de-embed:

a Embed - This option calls for the UDF function "Convolve".
FUNCTION 3 is assigned to "Convolve" FUNCTION 1, which is the
differential source.

b De-embeded - This option calls for the UDF function "Deconvolve".
FUNCTION 3 is assigned to "Deconvolve" FUNCTION 1, which is the
differential source.

¢ None - No embed or de-embed takes place and the original
differential source on FUNCTION 1 is used to perform the analysis.

Embed/De-embed Setings
" De-embed {* Embed " MNone

Select embed/de-embed setup rr'ﬂde|;.'.,|_rt.;.mate.:| Setup j

Software will automate embed/de-embed setup.

Load S-parameter: |C\Documents and Settings'All  Browse

USB 3.0 Electrical Compliance Testing Methods of Implementation



Far End (TP1) Transmitter Eye Tests

9 Under the Input Signal group, you may decide either to capture life

1

signal from the oscilloscope or load a pre-recorded signal to be tested:

a Life Signal - Live signal is captured and analyzed directly from the
oscilloscope.

b Recorded Signal - Pre-recorded waveform saved as waveform file
(*.bin) format is loaded and analyzed. Only tests carried out by the
USB-IF Sigtest are available with this option.

Input Signal
Select input signal t;pe:|Uve signal -

Load bin file: |

10 Under the Test Report group, you may enter comments to be included
in the test report.

Test Report

|Iser Comments:

11 Click the Select Tests tab and check the tests you want to run. Check
the parent node or group to check all the available tests within the
group.

USB 3.0 Electrical Compliance Testing Methods of Implementation
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USB3.0 -- USB3 Device 1 *
File View Tools Help

D@ 202 @ e

Task Flow _| Setup SelectTests | Configure | Connect | Run Tests | Resuts | Himi Report
Fl =[] © Al USBE3 Tests
£ =[O USB3Tests (5.0 GT/s)
= [¥] © Transmitter Eye Far End (TP1) Tests
Select Tests

) Far End Unit Interval (with S5C)

) Far End 55C Slew Rate

) Far End Template Test

) Far End Peak-To-Peak Differential Qutput Voltage
) Far End RMS Random Jitter

[¥] © Far End Maximum Deterministic Jitter

) Far End Total Jitter at BER-12

Description: (Select a Single Test)
Limit Set: USE 3.0 Specifcation version 1.0

Test: (None Selected)

I 7 Tests |Check the test(s) you would like to run |Cor1r1ecﬁon: LNEMOWN Y

Figure 6  Selecting Far End (TP1) Transmitter Eye Tests

12 Set up the test parameters in the configuration options, run the test,
and view the test results.
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Far End Unit Interval Test Method of Implementation

1

The purpose of this test is to verify that the unit interval measured at the

transmitter far end (TP1) of the transmitter is within the conformance

limits specified in Table 6-10 (without SSC) and Table 6-9 (with SSC) of

the USB 3.0 specification.

Test Definition Notes from the Specification

Table 10 Transmitter Normative Electrical Parameters

Symbol Parameter 5.0 GT/s Units  Parameter
ul Unit Interval 199.94 (min) ps The specified Ul is equivalent to a tolerance of +
200.06 (max) 300ppm for each device. Period does not account for
SSC induced variations.
V1x.DIFE-PP Differential p-p 0.8 (min) v Nominal is 1V p-p.
Tx voltage swing 1.2 (max)

Vix.Dire-pLow  Low-Power 0.4 (min) v There is no de-emphasis requirement in this mode.
Differential p-p 1.2 (max) De-emphasis is implementation-specific for this
Tx voltage swing mode.

V1x-DE-RATIO Tx de-emphasis 3.0 (min) dB Nominal is 3.5 dB.

4.0 (max)

RTX-DlFF-DC DC differential 72 (min) Q
impedance 120 (max)

Vxrev.peTect  The amount of 0.6 (max) v Detect voltage transition should be an increase in
voltage change voltage on the pin looking at the detect signal to avoid
allowed during a high impedance requirement when an “off”
Receiver Detection receiver’s input goes below ground.

CAC-COUPLING AC Coupling 75 (min) nF All Transmitters shall be AC coupled. The AC coupling
Capacitor 200 (max) is required either within the media or within the

transmitting component itself.

tcpr stew max ~ Maximum slew rate 10 ms/s  See the jitter white paper for details on this

measurement. This is a df/ft specification.
Table 11 SSC Parameters
Symbol Description Limits Units Note
Min Max
tSSC-MOD-RATE Modulation Rate 30 33 kHz
tSSC-FREQ-DEVIATlON SSC deviation +0/-4000 +0/-5000 ppm 1.2

USB 3.0 Electrical Compliance Testing Methods of Implementation
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NOTE:

1

2

The data rate is modulated from Oppm to -5000ppm of the nominal
data rate frequency and scales with data rate.

This is measured below 2 MHz only.

Table 6-9 translates to:

Max Unit Interval = 200.0ps + 5300ppm = 201.06ps

Min Unit Interval = 200.0ps - 300ppm = 199.94ps

Measurement Algorithm

1

10
1"

Make the connections as described in “Setting Up the USB 3.0 Test
Environment" on page 19. The horizontal and vertical scales of the
oscilloscope are adjusted as described in there.

Save the oscilloscope settings prior to turning on the measurement
trending. The saved settings will be reloaded at the end of this test so
that the next test does not need to perform the steps described in
“Setting Up the USB 3.0 Test Environment“ again.

Split the oscilloscope's display into 2 graticules: the top displays the
source waveform and the bottom displays the unit interval trend
waveform.

Turn on the unit interval measurement.

Enable the jitter mode to view measurement trends. Enable the
measurement trend to trend the unit interval measurement with 3499
smoothing points.

Assign FUNCTION 4 to magnify the measurement trend at a factor of 1.
Autoscale FUNCTION 4 so that the full signal is displayed.

Measure the average of FUNCTION 4 to obtain the average unit interval.
Measure the max of FUNCTION 4 to get the maximum unit interval.
Measure the min of FUNCTION 4 to get the minimum unit interval.
Compare the test result with the compliance test limit.

Reload the saved oscilloscope settings before proceeding to the next
test.

Pass Condition

The measured average unit interval at TP1 is within the limits specified in
Table 6-10 (without SSC) and Table 6-9 (with SSC) of the USB 3.0
Specification.
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Test References

See Table 6-10 Transmitter Normative Electrical Parameters and Table 6-9
SSC Parameters in the USB 3.0 Specification, version 1.0.
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Far End SSC Slew Rate Test Method of Implementation

The purpose of this test is to ensure that the combination of SSC and all
other jitter sources within the bandwidth of the CDR does not exceed the
allowed slew rate. The peak of the period jitter must not exceed
Tepr sLEw max listed in Table 6-10 of the USB 3.0 specification.

Test Definition Notes from the Specification

Table 12 Transmitter Normative Electrical Parameters

Symbol Parameter 5.0 GT/s Units  Parameter
ul Unit Interval 199.94 (min) ps The specified Ul is equivalent to a tolerance of +
200.06 (max) 300ppm for each device. Period does not account for
SSC induced variations.
V1x.DIFE-PP Differential p-p 0.8 (min) v Nominalis 1V p-p.
Tx voltage swing 1.2 (max)

Vix.Dire-pLow  Low-Power 0.4 (min) v There is no de-emphasis requirement in this mode.
Differential p-p 1.2 (max) De-emphasis is implementation-specific for this
Tx voltage swing mode.

V1x-DE-RATIO Tx de-emphasis 3.0 (min) dB Nominal is 3.5 dB.

4.0 (max)

RTX-DlFF-DC DC differential 72 (min) Q
impedance 120 (max)

Vxrev.peTect  The amount of 0.6 (max) v Detect voltage transition should be an increase in
voltage change voltage on the pin looking at the detect signal to avoid
allowed during a high impedance requirement when an “off”
Receiver Detection receiver’s input goes below ground.

CAC-COUPLING AC Coupling 75 (min) nF All Transmitters shall be AC coupled. The AC coupling
Capacitor 200 (max) is required either within the media or within the

transmitting component itself.

tcpr stew max ~ Maximum slew rate 10 ms/s  See the jitter white paper for details on this
measurement. This is a df/ft specification.

Measurement Algorithm

1 Make the connections as described in “Setting Up the USB 3.0 Test
Environment" on page 19. The horizontal and vertical scales of the
oscilloscope are adjusted as described in there.

2 Save the oscilloscope settings prior to turning on the measurement
trending. The saved settings will be reloaded at the end of this test so
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that the next test does not need to perform the steps described in
“Setting Up the USB 3.0 Test Environment® again.

3 Split the oscilloscope's display into 2 graticules: the top displays the
source waveform and the bottom displays the unit interval trend
waveform.

4 Turn on the unit interval measurement.

5 Enable the jitter mode to view the measurement trends. Enable the
measurement trend to trend the unit interval measurement with 3499
smoothing points.

6 Assign FUNCTION 4 to magnify the measurement trend at a factor of 1.
Autoscale FUNCTION 4 so that the full signal is displayed.

7 Read the measurement trend waveform into the memory.

8 The saved waveform is analyzed by using MATLAB. For the algorithm to
determine the slew rate, refer to white paper USB 3.0 CDR Model
White Paper, revision 0.5 available at www.usb.org.

9 Compare the test result with the compliance test limit.

10 Reload the saved oscilloscope settings before proceeding to the next
test.

Pass Condition

The maximum slew rate must not exceed the slew rate limit in Table 6-10
of the USB 3.0 Specification.

Test References

See Table 6-10 Transmitter Normative Electrical Parameters in the USB
3.0 Specification, version 1.0.
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Far End Template Test Method of Implementation
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The purpose of this test is to perform an eye mask test at TP1 by using
the eye mask template as specified in Section 6.7.3, Tables 6-12 of the
USB 3.0 specification.

Table 6-12 specifies that minimal eye height should be 100mV.
Table 6-12 also specifies that total jitter is 0.66 UL

Therefore, the Near End transmitter eye test uses the following limits:
e Upper/Lower rail = 1.2Vmax, i.e. +/-0.6V
¢ Diamond upper/lower = 100mVmin, i.e. +/-0.05V

¢ Diamond width

1UI - Total jitter

1U0I - 0.66UI = 0.34UI = 0.34UI/2 = +/-0.17UI

Test Definition Notes from the Specification

Table 13 Normative Transmitter Eye Mask at Test Point TP1

Signal Characteristics Minimal Nominal Maximum Units Note

Eye Height 100 1200 mV 24

Dj 0.43 ul 1,23

Ri 0.23 ul 1,235

Tj 0.66 ul 12,3
NOTES:

1. Measured over 10® consecutive UI and extrapolated to 10"!2 BER.
2. Measured after receiver equalization function.
3. Measured at end of reference channel and cables at TP1.

4. The eye height is to be measured at the maximum opening (at the
center of the eye width +0.05UI).

5. The Rj specification is calculated as 14.069 times the RMS random jitter
for 10"'2 BER.
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Measurement Algorithm

1 Make the connections as described in “Setting Up the USB 3.0 Test
Environment" on page 19. The horizontal and vertical scales of the
oscilloscope are adjusted as described in there.

2 Using the USB-IF SigTest:

Acquire and save the waveform into

C:\Documents and Settings\All Users\Application Data\Agilent\
Infiniium\Apps\USB3Test\Project\USB3.bin

Call the USB SigTest to analyze the saved waveform
3 Using the Agilent SDA:

Turn on the color grade display.

Enable the mask test and load the mask. The mask template can be

found at:

C:\Program Files\Agilent\Infiniium\Apps\USB3Test\app\masks\
USBMask_FarEnd.msk

Set up the clock recovery by using 2nd order PLL with data rate of

5Gb/s, loop bandwidth of 4.9MHz and damping factor of 0.707.
Enable Real Time Eye to fold the waveform.

4 Compare the test result with the compliance test limit.

Pass Condition

The test passes if the waveform does not violate the mask.

Test References

See Table 6-12 Normative Transmitter Eye Mask at Test Point TP1 in the

USB 3.0 Specification, version 1.0.
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Far End Peak-to-Peak Differential Output Voltage Test Method of
Implementation

The purpose of this test is to verify that the peak differential output
voltage measured at TP1 meets the minimum eye height as specified in
Table 6-12 of the USB 3.0 specification.

Test Definition Notes from the Specification

Table 14 Normative Transmitter Eye Mask at Test Point TP1

Signal Characteristics Minimal Nominal Maximum Units Note

Eye Height 100 1200 mV 24

Dj 0.43 ul 1,23

Rj 0.23 ul 1,235

Tj 0.66 ul 12,3
NOTES:

1. Measured over 10% consecutive UI and extrapolated to 10"'2 BER.
2. Measured after receiver equalization function.
3. Measured at end of reference channel and cables at TP1.

4. The eye height is to be measured at the maximum opening (at the
center of the eye width +0.05UI).

5. The Rj specification is calculated as 14.069 times the RMS random jitter
for 10"'2 BER.

Measurement Algorithm

1 Make the connections as described in “Setting Up the USB 3.0 Test
Environment" on page 19. The horizontal and vertical scales of the
oscilloscope are adjusted as described in there.

2 Using the USB-IF SigTest:

Acquire and save the waveform into

C:\Documents and Settings\All Users\Application Data\Agilent\
Infiniium\Apps\USB3Test\Project\USB3.bin

Call the USB SigTest to analyze the saved waveform
3 Using the Agilent SDA:
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Turn on the color grade display.

Set up the clock recovery by using 2nd order PLL with data rate of
5Gb/s, loop bandwidth of 4.9MHz and damping factor of 0.707.

Enable the Real Time Eye to fold the waveform.
Measure the min and max value of the waveform.

The peak differential voltage is

Peak diff voltage = Max voltage - Min voltage

4 Compare the test result with the compliance test limit.

Pass Condition

The measured peak differential output voltage measured at TP1 meets the
minimum eye height as specified in Table 6-12 of the USB 3.0
specification.

Test References

See Table 6-12 Normative Transmitter Eye Mask at Test Point TP1 in the
USB 3.0 Specification, version 1.0.
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Far End RMS Random Jitter Test Method of Implementation

The purpose of this test is to verify that the measured RMS random jitter,
Rj measured at TP1 is within the limits as specified in Table 6-12 of the
USB 3.0 specification.

Rj Total is computed as the Root Sum Square of the individual Rj
components.

Test Definition Notes from the Specification

Table 15 Normative Transmitter Eye Mask at Test Point TP1

Signal Characteristics Minimal Nominal Maximum Units Note

Eye Height 100 1200 mV 24

Dj 0.43 ul 1,2,3

Ri 0.23 ul 1,2,35

Tj 0.66 ul 12,3
NOTES:

1. Measured over 10° consecutive UI and extrapolated to 10" 2 BER.
2. Measured after receiver equalization function.
3. Measured at end of reference channel and cables at TP1.

4. The eye height is to be measured at the maximum opening (at the
center of the eye width +0.05UI).

5. The Rj specification is calculated as 14.069 times the RMS random jitter
for 10"'2 BER.

Measurement Algorithm

1 Make the connections as described in “Setting Up the USB 3.0 Test
Environment" on page 19. The horizontal and vertical scales of the
oscilloscope are adjusted as described in there.

2 Using the USB-IF SigTest:

Acquire and save the waveform into

C:\Documents and Settings\All Users\Application Data\Agilent\
Infiniium\ Apps\USB3Test\Project\USB3.bin

Call the USB SigTest to analyze the saved waveform
3 Using the Agilent SDA (in this case, the EZJIT+):
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Enable Jitter mode on EZJIT+.

Perform RjDj measurements by using the following setup:
BER: E-12
Pattern length: arbitrary
Leading coefficient: -2
Lagging coefficient: 5
Rj Bandwidth: Narrow
Setup clock recovery:

2nd Order PLL, data rate of 5Gb/s, loop bandwidth of 4.9MHz, damping
factor of 0.707

Get Rj reading

4 Compare the test result with compliance test limit.

Pass Condition

The measured RMS random jitter, Rj measured at TP1 is within the limit
as specified in Table 6-12 of the USB 3.0 specification.

Test References

See Table 6-12 Normative Transmitter Eye Mask at Test Point TP1 in the
USB 3.0 Specification, version 1.0.
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Far End Maximum Deterministic Jitter Test Method of Implementation

62

The purpose of this test is to verify that the measured deterministic jitter,
Dj measured at TP1 is within the limits as specified in Table 6-12 of the
USB 3.0 specification.

Dj is computed by using the Dual Dirac method.

Test Definition Notes from the Specification

Table 16 Normative Transmitter Eye Mask at Test Point TP1

Signal Characteristics Minimal Nominal Maximum Units Note

Eye Height 100 1200 mV 24

Dj 0.43 ul 1,23

Ri 0.23 ul 1,235

Tj 0.66 ul 1,23
NOTES:

1. Measured over 10® consecutive UI and extrapolated to 10"!2 BER.
2. Measured after receiver equalization function.
3. Measured at end of reference channel and cables at TP1.

4. The eye height is to be measured at the maximum opening (at the
center of the eye width +0.05UI).

5. The Rj specification is calculated as 14.069 times the RMS random jitter
for 102 BER.

Measurement Algorithm

1 Make the connections as described in “Setting Up the USB 3.0 Test
Environment" on page 19. The horizontal and vertical scales of the
oscilloscope are adjusted as described in there.

2 Using the USB-IF SigTest:

Acquire and save the waveform into

C:\Documents and Settings\All Users\Application Data\Agilent\
Infiniium\Apps\USB3Test\Project\USB3.bin

Call the USB SigTest to analyze the saved waveform
3 Using the Agilent SDA (in this case, the EZJIT+):
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Enable Jitter mode on EZJIT+.

Perform RjDj measurements by using the following setup:
BER: E-12
Pattern length: arbitrary
Leading coefficient: -2
Lagging coefficient: 5
Rj Bandwidth: Narrow
Setup clock recovery:

2nd Order PLL, data rate of 5Gb/s, loop bandwidth of 4.9MHz, damping
factor of 0.707

Get Dj reading

4 Compare the test result with compliance test limit.

Pass Condition

The measured maximum deterministic jitter, Dj measured at TP1 is within
the limit as specified in Table 6-12 of the USB 3.0 specification.

Test References

See Table 6-12 Normative Transmitter Eye Mask at Test Point TP1 in the
USB 3.0 Specification, version 1.0.
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Far End Total Jitter at BER-12 Test Method of Implementation

64

The purpose of this test is to verify that the measured total jitter, Tj
measured at TP1 is within the limits as specified in Table 6-12 of the USB

3.0 specification.

Tj at a 10"'2 BER is calculated as 14.068 x Rj + Dj.

Test Definition Notes from the Specification

Table 17 Normative Transmitter Eye Mask at Test Point TP1

Signal Characteristics Minimal Nominal Maximum Units Note

Eye Height 100 1200 mV 24

Dj 0.43 ul 1,23

Ri 0.23 ul 1,235

Tj 0.66 ul 1,23
NOTES:

1. Measured over 10® consecutive UI and extrapolated to 10"!2 BER.

2. Measured after receiver equalization function.

3. Measured at end of reference channel and cables at TP1.

4. The eye height is to be measured at the maximum opening (at the

center of the eye width +0.05UI).

5. The Rj specification is calculated as 14.069 times the RMS random jitter

for 102 BER.

Measurement Algorithm

1 Make the connections as described in “Setting Up the USB 3.0 Test
Environment" on page 19. The horizontal and vertical scales of the

oscilloscope are adjusted as described in there.
2 Using the USB-IF SigTest:

Acquire and save the waveform into

C:\Documents and Settings\All Users\Application Data\Agilent\

Infiniium\Apps\USB3Test\Project\USB3.bin

Call the USB SigTest to analyze the saved waveform

3 Using the Agilent SDA (in this case, the EZJIT+):
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Enable Jitter mode on EZJIT+.

Perform RjDj measurements by using the following setup:
BER: E-12
Pattern length: arbitrary
Leading coefficient: -2
Lagging coefficient: 5
Rj Bandwidth: Narrow
Setup clock recovery:

2nd Order PLL, data rate of 5Gb/s, loop bandwidth of 4.9MHz, damping
factor of 0.707

Get Rj and Dj reading

Calculate total jitter Tj using formula:
Tj = 14.068 * Rj + Dj
4 Compare the test result with compliance test limit.
Pass Condition

The measured total jitter, Tj measured at TP1 is within the limit as
specified in Table 6-12 of the USB 3.0 specification.

Test References

See Table 6-12 Normative Transmitter Eye Mask at Test Point TP1 in the
USB 3.0 Specification, version 1.0.
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o Methods of Implementation
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Calibrating the 80000B and 90000A
.* ©® ¢ Series Infiniium Oscilloscopes

To Run the Self Calibration 67
Self Calibration 68

This section describes the Agilent 80000B and 90000A Series Infiniium
oscilloscopes calibration procedures.

To Run the Self Calibration

Let the Oscilloscope Warm Up Before Adjusting. Warm up the oscilloscope for 30 minutes
before starting calibration procedure. Failure to allow warm up may result in inaccurate
calibration.

The self calibration uses signals generated in the oscilloscope to calibrate
channel sensitivity, offsets, and trigger parameters. You should run the self
calibration

e yearly, or according to your periodic needs,
* when you replace the acquisition assembly or acquisition hybrids,
* when you replace the hard drive or any other assembly,

e when the oscilloscope’s operating temperature (after the 30 minute
warm-up period) is more than +*5 °C different from that of the last
calibration.

To calibrate the Infiniium oscilloscope in preparation for running the USB
3.0 automated tests, you need the following equipment:

Table 18 Equipment Required

Equipment Critical Specifications Agilent Part
Number

Adapters (2 supplied with oscilloscope 3.5 mm (f) to precision BNC No Agilent

except for the DS090254A) substitute 54855-67604

H
‘e®
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Calibrating the 80000B and 90000A Series Infiniium Oscilloscopes

Table 18 Equipment Required

Equipment Critical Specifications Agilent Part
Number
Cable Assembly 50 Q characteristic impedance BNC (m)  Agilent

connectors ~ 36 inches (91 cm) to 48 8120-1840
inches (122 cm) long

Cable Assembly (supplied with No substitute Agilent
oscilloscope except for the DS090254A 54855-61620
which can use a good quality BNC cable)

10 MHz Signal Source (required for time  Frequency accuracy better than 0.4 ppm  Agilent
scale calibration) 53131A with
Opt. 010

Self Calibration

68

Calibration time: It will take approximately 1 hour to run the self calibration on the
oscilloscope, including the time required to change cables from channel to channel.

1 Let the Oscilloscope Warm Up Before Running the Self Calibration.

The self calibration should only be done after the oscilloscope has run
for 30 minutes at ambient temperature with the cover installed.
Calibration of an oscilloscope that has not warmed up may result in an
inaccurate calibration.

2 Pull down the Utilities menu and Select Calibration.

3 Click the check box to clear the Cal Memory Protect condition.

You cannot run self calibration if this box is checked. See Figure 7.
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Calibration
IR Calibration Status: Calibrated Close
Probe Comp = Callbration ATemp: -59C
Calibration Date: 31 3L 2006 11:15:41 Help ﬂ
Time Scale Cal aTermp;  0°C
Time Scale Cal Date: 21 APR 2006 13:12:33

v Cal Memory Protect

Start

Calibration Status

Common Passed

Clear this check box Charnel Wertical Trigger
. 1 Passed Passed

before starting 2 Passed Passed
. . 3 Passed Passed
calibration 4 Passed Passed

Al Passed
I Details

Probe calibration is accessed via the Channel Dlalogs

Figure 7 Oscilloscope Calibration Window

4 C(Click Start, then follow the instructions on the screen.

The routine will ask you to do the following things in sequence:

a Decide if you want to perform the Time Scale Calibration. Your
choices are:

Standard Calibration - Time scale calibration will not be performed.
Time scale calibration factors from the previous time scale
calibration will be used and the 10 MHz reference signal will not be
required. The remaining calibration procedure will continue.

Standard Calibration and Time Scale Calibration - Performs the time
scale calibration. This option requires you to connect a 10 MHz
reference signal to channel 1 that meets the following specifications.
Failure to use a reference signal that meets this specification will
result in an inaccurate calibration.

Frequency: 10 MHz +0.4 ppm = 10 MHz 4 Hz
Amplitude: 0.2 Vpeak-to-peak to 5.0 Vpeak-to-peak

Wave shape: Sine or Square
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Standard Calibration and Reset Time Scale Calibration - Factory
time scale calibration factors will be used. The 10 MHz reference
signal will not be required. The remaining calibration procedure will
continue.

Disconnect everything from all inputs and Aux Out.
Connect the calibration cable from Aux Out to channel 1.

You must use the 54855-61620 cable assembly with two 54855- 67604
adapters for all oscilloscopes except for the DSO90254A which can
use a good quality BNC cable. Failure to use the appropriate
calibration cable will result in an inaccurate calibration.

Connect the calibration cable from Aux Out to each of the channel
inputs as requested.

Connect the 50 U BNC cable from the Aux Out to the Aux Trig on
the front panel of the oscilloscope.

A Passed/Failed indication is displayed for each calibration section.
If any section fails, check the calibration cables and run the
oscilloscope Self Test in the Utilities menu.

After the calibration procedure is completed, click Close.
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